
MaineYankee
RELIABLE ELECTRICITY SINCE 1972

EDISON DRIVE ~ AUGUSTA. MAINE 04330 ~ (207) 622 4868

December 7, 1992
HN-92-125 JRH-92-176

UNITED STATES NUCLEAR REGULATORY COMMISSION
Attention: Document Control Desk
Washington, DC 20555

References: a) License No. DPR-36 (Docket No. 50-309)
b) HYAPCo Letter to USNRC re: EROS - Data Point Library (DPL) dated

25 September 1992 (HN-92-94)

Subject: EROS — DPL

Gentlemen:

Please find enclosed two (2) complete copies of the final Data Point Library
(DPL) for the Maine Yankee EROS. The enclosed DPL includes the following additional
information from that transmitted via Reference (b):

~ The editorial changes that were faxed to Hr. John Jolicoeur on 29 October
1992.

~ In response to a telephone request from Hr. Jolicoeur to Hr. Eric Johnson
in early November, 1992, conversion units have been included for four
parameters (Rx vessel water level, Steam Generators 1, 2 and 3 levels) and
additional descriptive information has been provided for three other ERDS
parameters (HPSI flow, LPSI flow, BWST level). This information is
identified by underscoring in the enclosed DPL.

~ Vacant data fields for all parameters have been filled with "N/A" which
means not applicable.

We trust that this information is satisfactory to permit the conduct of the two
remaining ERDS tests — a functional test with NRC's contr actor and a final test with
NRC Operations Center. Please contact Mr. Eric Johnson, Computer Engineer, at (207)
882-5630 to schedule these tests, or Mr. Stephen D. Evans, Section Head, Emergency
Preparedness/Environmental Engineering at the letterhead address regarding
programmatic issues.

Very truly yours,

SDE/jag

Enclosures (2)

James R. Heber t, Acting Manager
Licensing & Engineering Support Department

c: (w/o enc.) Mr. Thomas T. Martin
Hr . Charles S. Harschall
Hr. E. H. Trottier
Hr. Patrick J. Dostie
Hr. Eric Johnson
Hr. John Jolicoeur (w/enc.)

L:Urhhltr sUrh92176.1tr
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Records Organize Go To Exit
DATA POINT LIBRARY REFERENCE FILE

e: 12/03/92 Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: NI-POWER-RNG Point Id: 856Site Desc: RX '.PWR NI-1A CHNL WRLOG NIY-001
ERDS Desc: NUCLEAR INSTRUMENTS, POWER RANGE Analog/Digital: AEngr. Units: '-.PWR Units Conv: LOGARITHMIC
Min. Inst. Range: 10E-7 Max. Inst. Range: 100
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: In shield tank surrounding Rx vessel
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: 1000 CPS
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: At 1000 CPS detector goes from 3 fission chambers to 1fission chamber and from CPS to '-.PWR. This parameterEdit ~C:gerds~MY1 DPL ~Rec 1/50 >File ~ 6



Records is not valid in CPS range.

Edit nC:herds/MY1 DPL <Rec 1/50 >File <





Records

e: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MYl

a Feeder: 1 ERDS Parameter: NI-INTER-RNG Point Id: 873Site Desc: RX %PWR NI-4D CHNL WRLOG NIY-004
ERDS Desc: NUCLEAR INST, INTERMEDIATE RANGE Analog/Digital: AEngr. Units: '-.PWR Units Conv: LOGARITHMIC
Min. Inst. Range: 10E-7 Max. Inst. Range: 100
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: In shield tank surrounding Rx vessel
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: 1000 CPS
NI Detector Power Supply Turn-On Power Level: n/aInstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: At 1000 CPS detector goes from 3 fission chambers to 1fission chamber and from CPS to %PWR. This parameter isEdit nC:herds)MY1 DPL nRec 2/50 >File >RecLock n



Records
II

not valid in CPS range.

Edit <C:herds)MYl DPL ~Rec 2/50 <File >RecLock <
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te: 12/03/92
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DATA POINT LiBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: NI-SOURC-RNG Point Id: 874Site Desc: RX CPS NI-1A CHNL WRLOG NIY-001-A
ERDS Desc: NUCLEAR INST., SOURCE RANGE Analog/Digital: AEngr. Units: C.P.S. Units Conv: LOGARITHMIC
Min. Inst. Range: 1 Max. Inst. Range: 1000
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: In shield tank surrounding Rx vessel
Alarm/Trig Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: 1000 CPS
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: At 1000 CPS detector goes from 3 fission chambers to 1fission chamber and from CPS to %PWR. This parameter isEdit nC:herds(MY1 DPL ~Rec 3/50 nFile ~RecLock >



Records not valid in '-.PWR range.

Edit >C:gerds~MY1 DPL nRec 3/50 ~File nRecLock <
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te: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

ERDS Parameter: REAC-VES-LEV Point Id: 870

Analog/Digital: A

nFile ~

a Feeder: 1
Site Desc: PITS CH A
ERDS Desc: REACTOR VESSEL WATER LEVEL
Engr. Units: ';LEVEL Units Conv: 1-. = 4.95"
Min. Inst. Range: 0 Max. Inst. Range: 100
Zero Point Ref: TNKBOT Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: REACTOR CONTAINMENT

-2'larm/TripSet Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: n/a
Temperature Compensation for DP Transmitters: n
Level Reference Leg: WET
System Desc: 0-. is at containment elevation

-13.79'o

of active fuel is at 21.45'.
Edit <C:herds MY1 DPL <Rec 4 50



Records Bottom of active fuel is at
10.0'.'ensitycompensate eve ranging from bottom of Rx vessel

to top of pressurizer

Edit >C:herds(MY1 DPL >Rec 4/50 nFile oRecLock <
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DATA POINT LIBRARY REFERENCE FILE

e: 12/03/92 Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: TEMP-CORE-EX Point Id: 1744Site Desc: MAX INCORE T/C TEMP
ERDS Desc: HIGHEST TEMPERATURE AT CORE EXIT Analog/Digital: A
Engr. Units: DEG F Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 2300
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: P Number of Sensors: 45
How Processed: Maximum value of all good sensors
Sensor Loc: On top of fuel bundles
Alarm/Trip Set Pox.nts: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: Next highest T/C indication
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit <C:gerds~MY1 DPL >Rec 5/50 ~File nRecLock <



Records

Edit <C:herds)MY1 DPL ORec 5/50 ~File <RecLock <



Records
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DATA POINT LIBRARY REFERENCE FILE

e: 12/03/92 Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: SUB-MARGIN Point Id: 824Site Desc: CORE MARG TO SAT SMY-100-A
ERDS Desc: SATURATION TEMP - HIGHEST CET Analog/Digital: A
Engr. Units: DEGF Units Conv: n/a
Min. Inst. Range: -50 Max. Inst. Range: 200 .
Zero Point Ref: n/a Ref. Notes: n/a

- Proc or Sens: S Number of Sensors: 16
How Processed: n/a
Sensor Loc: MULTIPLE SENSORS
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: n/a
Temperature Comgensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: Uses inputs from 16 core exit thermocouples which are

selected on the control board. Parameter is calculatedEdit <C:gerds~MY1 DPL ~Rec 6/50 ~File <RecLock <



Records by an analog computer. Results feed to plant computer as
a single analog signal.

Edit >C:herds)MYl DPL >Rec 6/50 <File nRecLock n
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e: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

Qp'~ ~ lQ+
QD~ -Pcg) u4

a Feeder: 1 ERDS Parameter: CORE-FLOW Point Id: 2520Site Desc: TOTAL RCS FLOW FOR LOOPS 1-3
ERDS Desc: TOTAL REACTOR COOLANT FLOW Analog/Digital: A
Engr. Units: KGPM Units Conv: n/a
Min. Inst. Range: n/a Max. Inst. Range: n/a
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: P Number of Sensors: 3
How Processed: CALCULATED FROM STEAM OR FEED FLOWS
Sensor Loc: n/a
Alarm/Trip Set Points: 93%. of max flow, low from RPS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: n/a
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: PTIDs used as flow inputs depend on calorimteric power

PWR ( 50o not calculated (indicates 999)Edit <C:4erds~MY1 DPL <Rec 7/50 ~File <RecLock n



Records 50%'= PWR ( 90'o
PWR )= 90o

Feed Flow
Steam Flow

Flow is calculated using RCS temperature, density, andenthalpy.

Edit nC:herds)MY1 DPL <Rec 7/50 nFile n
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e: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit:. MY1

a Feeder: 1 ERDS Parameter: SG-LEVEL-1/A Point Id: 878Site Desc: SG1 LEVEL LT-1213C
ERDS Desc: STEAM GENERATOR 1/A WATER LEVEL Analog/Digital: A
Engr. Units: PERCNT Units Conv: 1-: = 1.9" level
Min. Inst. Range: 0 Max. nst. Range: 100
Zero Point Ref: COMPLX Ref. Notes: zero point is 285" above tube sheet
Proc or Sens: S Number of Sensors:
How Processed: n/a
Sensor Loc: CONTAZNMENT

-2'larm/TripSet Points: 35%, low from RPS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: N
Level Reference Leg: WET
System Desc: Computer low alarm at 58%

33% indicated (346") at top of S/G U-tubes.
Edit <C:herds)MY1 DPL ~Rec 8/50 ~File > U



Records 100% indicated is 475" above tube sheet.

Edit ~C:herds(MY1 DPL ~Rec 8/50 ~File G
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te: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: SG LEVEL 2/B Point Id: 879Site Desc: SG2 LEVEL LT-1223C
ERDS Desc: STEAM GENERATOR 2/B WATER LEVEL Analog/Digital: A
Engr. Units: PERCNT Units Conv: 1'; = 1.9" level
Min. Inst. Range: 0 Max. ns . ange: 100
Zero Point Ref: COMPLX Ref. Notes: zero oint is 285" above tube sheet
Proc or Sens: S Number of Sensors:
How Processed: n/a
Sensor Loc: CONTAINMENT

-2'larm/TripSet Points: 35%, low from RPS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/ainstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: N
Level Reference Leg: WET
System Desc: Computer low alarm at 58%

33'; indicated ~346") at top of 6/G U-tubes
Edit >C:gerds~MY1 DPL <Rec 9/50 nFile < 0



0



Records 100-. indicated is 475" above tube sheet.

Edit nC:'Iw,erds(MY1 DPL <Rec 9/50 <File <
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DATA POINT LIBRARY REFERENCE FILE

e: 12/03/92 Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: SG LEVEL 3/C Point Id: 880Site Desc: SG3 LEVEL LT-1233C
ERDS Desc: STEAM GENERATOR 3/C WATER LEVEL Analog/Digital: A
Engr. Units: PERCNT Units Conv: 1% = 1.9" level
Min. Inst. Range: 0 Max. nst. Range: 100
Zero Point Ref: COMPLX Ref. Notes: zero oint is 285" above tube sheet
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: CONTAINMENT

-2'larm/TripSet Points: 35-., low at RPS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: N
Level Reference Leg: WET
System Desc: Computer low alarm at 58';

33% indicated (346") at top of S/G U-tubes
Edit nC:gerds~MY1 DPL >Rec 10/50 <File n G





Records 100-: indicated is 475" above tube sheet

Edit <C:herds)NY1 DPL <Rec 10/50 <Pile < .
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DATA POINT LIBRARY REFERENCE FILE

e: 12/03/92 Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: SG PRESS 1/A Point Id: 228
Sz.te Desc: SG1 WR PRESS PT-1012
ERDS Desc: STEAM GENERATOR 1/A PRESSURE Analog/Digital: A
Engr .. Units: PSIG Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 1200
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: On main stm prior to 1st isolation valve
Alarm/Trip Set Points: 485, low from RPS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit ~C:herds)MY1 DPL nRec 11/50 <File ~RecLock <



Records

Edit <C:~erds~MY1 DPL <Rec 11/50 <File <RecLock ~
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te: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MYl

a Feeder: 1 ERDS Parameter: SG PRESS 2/B Point Id: 229Site Desc: SG2 WR PRESS PT-1022
ERDS Desc: STEAM GENERATOR 2/B PRESSURE Analog/Digital: AEngr. Units: PSIG Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 1200
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: On main stm prior to 1st isolation valveAlarm/Trip Set Points: 485, low from RPS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/aInstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit <C:herds(MY1 DPL <Rec 12/SO <File <RecLock <





Records

Edit <C:gerds~MY1 DPL >Rec 12/50 <File <RecLock <
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e: 12/03/92

'DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: SG PRESS 3/C Point Id: 230Site Desc: SG3 WR PRESS PT-1032
ERDS Desc: STEAM GENERATOR 3/C PRESSURE Analog/Digital: A
Engr. Units: PSIG Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 1200
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: On main stm prior to 1st isolation valve
Alarm/Trip Set Points: 485, low from RPS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit <C:gerds~MY1 DPL nRec 13/50'File >RecLock ~



Records

Edit <C:herds(MY1 DPL <Rec 13/50 <File <RecLock <
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te: 12/03/92
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DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

Feeder: 1 ERDS Parameter: MN FD FL 1/A Point Id: 1611
te Desc: SG1 FW FLO RATE

ERDS Desc: STM GEN 1/A MAIN FEED FLOW Analog/Digital: A
Engr. Units: Mg/HR Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 4.25
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: P Number of Sensors: 5
How Processed: Value is averaged over 2 minutes.
Sensor Loc: Flow dp is across venturi in S/G feed
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: N
Level Reference Leg: n/a
System Desc: Loop 1 feedwater flow is calculated from a raw DP sensor and

corrected using FW header pressure and average loop FW temp.Edit nC:~erds~MY1 DPL nRec 14/50 nFile n G





Records

If plant is on emergency or Aux FW, then first point heaters
are bypassed and this PTID will not read correctly.

Edit GC:herds)MY1 DPL ~Rec 14/50 ~File <
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"e: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

((g
mpf—F 0-F(

a Feeder: 1 ERDS Parameter: MN FD FL 2/B Point Id: 1612Site Desc: SG2 FW FLOW RATE
ERDS Desc: STM GEN 2/B MAIN FEED FLOW Analog/Digital: A
Engr. Units: Mg/HR Units Conv: n/a
Min. Inst. Range: n/a Max. Inst. Range: n/a
Zero Point Ref: 0 Ref. Notes: 4.25
Proc or Sens: P Number of Sensors: 5
How Processed: Value is averaged over 2 minutes
Sensor Loc: Flow dp is across venturi in S/G feed
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: N
Level Reference Leg: n/a
System Desc: Loop 2 feedwater flow is calculated form a raw DP sensor andcorrected using FW header pressure and loop average FW temp.Edit <C:herds)MY1 DPL >Rec 15/50 nFile ~ U



Records

Xf plant is on emergency or Aux FW, then first point heaters
are bypassed and this PTXD will not read correctly.

Edit ~C:4erds~MY1 DPL <Rec 15/50 nFile <
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e: 12/03/92

DATA POINT. LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: MN FD FL 3/C Point Id: 1613
Sate Desc: SG3 FW FLOW RATE
ERDS Desc: STM GEN 3/C MAIN FEED FLOW Analog/Digital: A
Engr. Units: Mg/HR Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 4.25
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: P Number of Sensors: 4
How Processed: Value is averaged over 2 minutes.
Sensor Loc: Flow dp is across venturi in S/G line
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: N
Level Reference Leg: n/a
System Desc: Loop 3 feedwater flow is calculated from a raw DP sensor and

corrected using FW header pressure and loop average FW temp.
Edit <C:herds)MY1 DPL <Rec 16/50 <File < 0





Records

If plant is on emergency or Aux FW, then first point heaters
are bypassed and this PTID will not read correctly.

Edit <C:herds)MY1 DPL GRec 16/50 >File <
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te: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: AX FD FL 1/A Point Id: 883ate Desc: LP1 EMER FD FL FY-1201A
ERDS Desc: STM QEN 1/A AUXILIARYFW FLOW Analog/Digital: AEngr. Units: QPM Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 1000
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: In emergency feed line to S/GAlarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/aNI Detector Power Supply Turn-On Power Level: n/aInstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: Uses an ultrasonic flow detector.
Edit <C:herds)MY1 DPL ~Rec 17/50 <File ~RecLock n



Records
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Edit ~C:4erds~MY1 DPL <Rec 17/50 <File <RecLock <
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e: 12/03/12

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

+(Vg
gp,pg ~ ax-Fb-/=c-<~~

a Feeder: 1 ERDS Parameter: AX FD FL 2/B Point Id: 882
Sate Desc: LP2 EMER FD FL FY-1201B
ERDS Desc: STM GEN 2/B AUXILIARYFW FLOW Analog/Digital: A'ngr. Units: GPM Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 1000
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: In emergency feed line to S/G
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: Uses an ultrasonic detector.
Edit ~C:herds)MY1 DPL >Rec 18/50 <File <RecLock <



Records

Edit ~C:herds)MY1 DPL ~Rec 18/50 ~File oRecLock ~
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DATA POINT LIBRARY REFERENCE FILE

te: 12/03/92 Reactor Unit: MYl

Feeder: 1 ERDS Parameter: AX FD FL 3/C Point Id: 881
e Desc: LP3 EMER FD FL FY-1201C

ERDS Desc: STM GEN 3/C AUXILIARYFW FLOW Analog/Digital: A
Engr. Units: GPM Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 1000
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: In emergency feed line to S/G
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a

J'ystemDesc: Uses ultrasonic detector.
Edit ~C:herds)MY1 DPL <Rec 19/50 ~File ~RecLock a



Records

Edit <C:~erds~NY1 DPL <Rec 19/50 <File ~RecLock <
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e: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: HL TEMP 1/A Point Id: 863Site Desc: LP1 HOT LEG TMP NR TY-112-HC
ERDS Desc: STM GEN 1/A INLET TEMPERATURE Analog/Digital: A
Engr. Units: DEGF Units Conv: n/a
Min. Inst. Range: 515 Max. Inst. Range: 665
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Between loop stop valve and S/G
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit ~C:herds)MY1 DPL ~Rec 20/50 <File nRecLock <



Records

Edit ~C:herds)MYl DPL <Rec 20/50 ~File <
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e: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: HL TEMP 2/B Point Id: 861Site Desc: LP2 HOT LEG TMP NR TY-122-HC
ERDS Desc: STM GEN 2/B INLET TEMPERATURE Analog/Digital: AEngr. Units: DEGF Units Conv: n/aMin. Inst. Range: 515 Max. Inst. Range: 665Zero Point Ref: n/a Ref. Notes: n/aProc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Between loop stop valve and S/GAlarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/aNI Detector Power Supply Turn-On Power Level: n/aInstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: nLevel Reference Leg: n/a
System Desc: n/a
Edit nC:herds)MY1 DPL <Rec 21/50. <File >RecLock <



Records

Edit ~C:herds)MY1 DPL ~Rec 21/50 ~Pile ~RecLock o





Records
DATA POINT LIBRARY REFERENCE FILE

"e: 12/03/92 Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: HL TEMP 3/C Point Id: 859Site Desc: LP3 HOT LEG TMP NR TY-132-HC
ERDS Desc: STM GEN 3/C INLET TEMPERATURE Analog/Digital: A
Engr. Units: DEGF Units Conv: n/a
Min. Inst. Range: 515 Max. Inst. Range: 665
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Between loop stop valve and S/G
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit <C:gerds~MY1 DPL ~Rec 22/50 ~File <RecLock <
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Edit ~C:herds)MY1 DPL ~Rec 22/50 aFile ~RecLock ~
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te: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

fC< ~ ) >Y$
'~Jq~,~r(.--0 g g — ~(~/~- )r,

a Feeder: 1 ERDS Parameter: CL TEMP 1/A Point Id: 430
Site Desc: LP1 CLD LEG TMP WR TT-115Y
ERDS Desc: STM GEN 1/A OUTLET TEMPERATURE Analog/Digital: A
Engr. Units: DEGF 'nits Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 600
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S . Number of Sensors: 1
How Processed: n/a
Sensor Loc: Between S/G outlet and RCP suction
Alarm/Trip Set Points: 500, low from computer
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit <C:herds(MY1 DPL nRec 23/50 nFile nRecLock <



Records

Edit <C:herds)MY1 DPL ~Rec 23/50 ~File ~RecLock <



Records

te: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MYl

a Feeder: 1 ERDS Parameter: CL TEMP 2/B Point Id: 431Site Desc: LP2 CLD LEG TMP WR TT-125Y
ERDS Desc: STM GEN 2/B OUTLET TEMPERATURE Analog/Digital: A
Engr. Units: DEGF Units Conv: n/a
Min. Inst. Range: 0 Max. inst. Range: 600
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Between S/G outlet and RCP suction
Alarm/Trip Set Points: 500, low from computer
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit <C:herds)MY1 DPL <Rec 24/50 ~File nRecLock <



Records

Edit ~C:herds(MY1 DPL GRec 24/50 <File <RecLock <
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Records
DATA POINT LIBRARY REFERENCE FILE

ate: 12/03/92 Reactor Unit: MY1

~ a Feeder: 1 ERDS Parameter: CL TEMP 3/C Point Id: 432te Desc: LP3 CLD LEG TMP WR TT-135Y
ERDS Desc: STM GEN 3/C OUTLET TEMPERATURE Analog/Digital: A
Engr. Units: DEGF Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 600
Zero Point Ref: n/a . Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Between S/G outlet and RCP suction
Alarm/Trip Set Points: 500, low from computer
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit >C:herds)MY1 DPL nRec 25/50 nFile <RecLock <





Records

Edit ~C:herds)MY1 DPL <Rec 25/50 <File GRecLock <



Records

Date: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: RCS PRESSURE Point Id: 827
e Desc: RCS PRESS PT-102Y

ERDS Desc: REACTOR COOLANT SYSTEM PRESSURE Analog/Digital: A
Engr. Units: PSIG Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 3250
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: 21'ONTAINMENT
Alarm/Trip Set Points: 1860, low from RPS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: RPS Alarm/Trip setpoint is variable, value given is lowest
Edit <C:herds(MY1 DPL <Rec 26/50 nFile >RecLock <
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Edit <C:~erds~MYl DPL <Rec 26/50 ~File <RecLock a





Records

Date: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MYl

gg<PQ ~O J Q Q
~~~~~—) N'zC-~vF<

a Feeder: 1 ERDS Parameter: PRZR LEVEL Point Id: 360
e Desc: PRZ LVL CH Y IND LT-101Y

ERDS Desc: PRIMARY SYSTEM PRESSURIZER LEVEL Analog/Digital: A
Engr. Units: -. LVL Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 100
Zero Point Ref: TOPHTR Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: REACTOR CONTAINMENT

20'larm/TripSet Points: 8.99, low from computer
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: n/a
Temperature Compensation for DP Transmitters: n
Level Reference Leg: WET
System Desc: 110 GAL/1-. indicated

Top of heater bundle is at 0'; indication.
Edit ~C:herds)MY1 DPL nRec 27/50 <File nRecLock <
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Edit <C:gerds~MY1 DPL <Rec 27/50 ~File <RecLock ~





Records

Date: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

Feeder: 1 ERDS Parameter: RCS CHG/MU Point Id: 366
e Desc: CHG PMP FLWRATE FT-212

ERDS Desc: PRIMARY CHARGING OR MAKEUP FLOW Analog/Digital: A
Engr. Units: GPM - Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 200
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: prior to flow control valve after pump
Alarm/Trip Set Points: 40.03, low from computer
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: N
Level Reference Leg: n/a
System Desc: n/a
Edit <C:gerds4MY1 DPL nRec 28/50 ~File <
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te: 12/03/92
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DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

Point Id: 2312Feeder: 1 ERDS Parameter: HP SI FLOWte Desc: TOTAL HPSI FLOW
ERDS Desc: HIGH PRESSURE SAFETY INJECT FLOW Analog/Digital: A
Engr. Units: GPM Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 900
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: P Number of Sensors: 3
How Processed: Sum of individual loop flows
Sensor Loc: Between HPSI flow control valve and loopAlarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/aInstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: N
Level Reference Leg: n/a
System Desc: Lower 10% of input instrument range is not consideredreliable. SPDS considers single loop flow < 30 GPMEdit <C:gerds~MY1 DPL nRec 29/50 >File < D



Records "BELOW READABLE FLOW"

Edit ~C:herds(MY1 DPL ~Rec 29/50 <File <
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DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: LP SI FLOWte Desc: TOTAL LPSI FLOW
ERDS Desc: LOW PRESSURE SAFETY INJECT FLOW Analog/Digital: A
Engr. Units: GPM Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 9000
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: P Number of Sensors: 3
How Processed: Sum of individual loop flows
Sensor Loc: Between flow control valve and loopAlarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: N
Level Reference Leg: n/a
System Desc: Lower 10% of input instrument range is not considered to

be reliable'PDS considers single loop flow < 300 GPMEdit <C:gerds~MY1 DPL ~Rec 30/50 nFile < G



Records "BELOW READABLE FLOW"

Edit <C:~erds~MY1 DPL <Rec 30/50 ~File ~





Records
DATA POINT LiBRARY REFERENCE FILE

Date: 12/03/92 Reactor Unit: MY1

Feeder: 1 ERDS Parameter: CTMNT SMP NR Point Id: 44
e Desc: CTMT SUMP LVL LY-307-K

ERDS Desc: CONTAINMENT SUMP NR LEVEL Analog/Digi al: AEngr. Units: FT Units Conv: n/a
Min. Inst. Range: 0.5 Max. Inst. Range: 8.0
Zero Point Ref: TNKBOT Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Rx containment

-2'larm/TripSet Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/aInstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: N/A
System Desc: 110 usable gallons at 1.9 FT ind'ted.

55 usable gallons at 0.95 FT in cated.Edit <C:4erds~MY1 DPL ~Rec 31/50 <File <RecLock n





Records This PTID is one of two full range sump levels

oi

Edit nC:gerds~MY1 DPL nRec 31/50 <File <RecLock <
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te: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

~ ci ndl-5~-v3R. L

a Feeder: 1 ERDS Parameter: CTMNT SMP WR Point Id: 844
~ te Desc: CTMT SUMP LVL LY-307-K
ERDS Desc: CONTAINMENT SUMP WR LEVEL Analog/Digital: AEngr. Units: FT Units Conv: n/a
Min. Inst. Range: 0.5 Max. Inst. Range: 8.0
Zero Point Ref: TNKBOT Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Rx containment

-2'larm/TripSet Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/aNI Detector Power Supply Turn-On Power Level: n/aInstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: nLevel Reference Leg: N/A
System Desc: 110 usable gallons at 1.9 FT indicated.

55 usable gallons at .95 FT indicated.Edit <C:herds)MY1 DPL ~Rec 32/50 >File <RecLock ~



Records This PTID is one of two full range sump levels

Edit ~C:herds)MY1 DPL ~Rec 32/50 >File <RecLock ~



Records
DATA POINT LIBRARY REFERENCE FILE

Date: 12/03/92 Reactor Unit: MY1

Feeder: 1 ERDS Parameter: EFF GAS RAD Point Id: 815
Desc: STACK GAS RI-3903

ERDS Desc: RADIOACTIVITYOF RELEASED GASSES Analog/Digital: A
Engr. Units: MR/HR - Units Conv: n/a
Min. Inst. Range: 10E-1 Max. Inst. Range: 10E7
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: See system description
Alarm/Trip Set Pox.nts: 8, high from RMS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: Computer high alarm at 1 mr/hr

The METPAC program used in the EOF area performs dose
Edit <C:herds)MY1 DPL ~Rec 33/50 <F~le nRecLock <



Records analyses. The METPAC operator can supply proper conversioncoefficients to microcurie/cc for a given time and accident
scenario, or output from the METPAC program.

Located between isokinetic nozzle (inside primary vent
stack) and sample pump suction. A particulate filter is
used prior to gas detector.

Edit <C:~erds~MY1 DPL <Rec 33/50 >File ~RecLock n



Records

Date: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

8 pC iry ~P /cj~

mls~ —~ C f~-Liu - RA>~

Feeder: 1 ERDS Parameter: EFF LIQ RAD Point Id: 791
e Desc: LIQUID WASTE DISPOSAL RI-3801

ERDS Desc: RADIOACTIVITYOF RELEASED LIQUID Analog/Digital: A
Engr. Units: CPM Units Conv: n/a
Min. Inst. Range: 10 Max. Inst. Range: 10E5
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: After pump discharge and prior to valve
Alarm/Trip Set Points: 30000, high from RMS and computer
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: The METPAC program used in the EOF area performs dose

analyses. The METPAC operator can supply proper conversion
Edit nC:~erds~MY1 DPL <Rec 34/50 >File nRecLock n



Records coefficients to microcurie/cc for a given time and accident
scenario, or output from the METPAC program.

Edit <C:herds)MY1 DPL nRec 34/50 <File nRecLock <
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Date: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

Feeder: 1 ERDS Parameter: COND A/E RAD Point Id: 799
e Desc: CONDENSOR AIR EJECTOR RI-1801

ERDS Desc: CONDENSOR AIR EJECTOR RADIOACT. Analog/Digital: A
Engr. Units: CPM Units Conv: n/a
Min. Inst. Range: 10 Max. Inst. Range: 10E6
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: In main condensor air ejector gas flow
Alarm/Trip Set Points: 70000, high from RMS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: Computer high alarm at 6000

Edit ~C:herds(MY1 DPL nRec 35/50 GFile GRecLock >
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Edit <C:herds)MY1 DPL >Rec 35/50 ~File <RecLock ~



Records
DATA POINT LIBRARY REFERENCE FILE
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Date: 12/03/92 Reactor Unit: MY1

Feeder: 1 ERDS Parameter: CNTMNT RAD Point Id: 845
e Desc: CTMT HI RNG RAD RM-6113A

ERDS Desc: RADIATION LEVEL IN CONTAINMENT Analog/Digital: A
Engr. Units: R/HR Units Conv: n/a
Min. Inst. Range: 1 Max. Inst. Range: 10ES
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: REACTOR CONTAINMENT

75'larm/TripSet Points: 10, high from RMS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit nC:~erds~MY1 DPL nRec 36/50 nFile nRecLock n
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Edit <C:herds)MY1 DPL ~Rec 36/50 <File <RecLock <



Records

Date: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: RCS LTDN RAD Point Id: 804
e Desc: REAC LETDOWN HI RI-3102

ERDS Desc: RAD LEVEL OF RCS LETDOWN LINE Analog/Digital: A
Engr. Units: CPM . Units Conv: n/a
Min. Inst. Range: 10 Max. Inst. Range: 10E6
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: In letdown flow
Alarm/Trip Set Points: 4000, high from RMS and computer
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: This flow bypasses the demineralizer train. Prior to the

detector there is a time delay coil to reduce nitrogen (16)
Edit <C:herds)MY1 DPL >Rec 37/50 ~File <RecLock <



Records gamma. There is no flow past detector after SIAS has fired.

Edit GC:4erds~MY1 DPL <Rec 37/50 <File <



Records

te: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: MAIN SL 1/A Point Id: 521te Desc: MN STM1 RAD MON RM-901A
ERDS Desc: STM GEN 1/A STEAM LINE RAD LEVEL Analog/Digital: A
Engr. Units: MR/HR Units Conv: n/a
Min. Inst. Range: 10E-1 Max. Inst. Range: 10E7
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Between S/G and first isolation valve
Alarm/Trip Set Points: 10, high from RMS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit >C:~erds~MY1 DPL nRec 38/50 >File ~RecLock <



Records

Edit <C:~erds~NY1 DPL
1

<Rec 38/50 ~File <RecLock >





Records

~ te: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: MAIN SL 2/B Point Id: 522site Desc: MN STM2 RAD MON RM-901B
ERDS Desc: STM GEN 2/B STEAM LINE RAD LEVEL Analog/Digital: A
Engr. Units: MR/HR Units Conv: n/a
Min. Inst. Range: 10E-1 Max. Inst. Range: lOE7
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Between S/G and first isolation valve
Alarm/Trip Set Points: 10, high from RMS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit nC:herds)MY1 DPL <Rec 39/50 nFile nRecLock n
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Edit <C:gerds4MY1 DPL ~Rec 39/50 <File <
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DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: MAIN SL 3/C Point Id: 523ate Desc: MN STM3 RAD MON RM-901C
ERDS Desc: STM GEN 3/C STEAM LINE RAD LEVEL Analog/Digital: AEngr. Units: MR/HR Units Conv: n/a
Min. Inst. Range: 10E-1 Max. Inst. Range 10E7Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Between S/G and first isolation valveAlarm/Trip Set Points: 10, high from RMS
NI Detector Power Supply Cut-Off Power Level: n/aNI Detector Power Supply Turn-On Power Level: n/aInstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: nLevel Reference Leg: n/a
System Desc: n/a

I'dit
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te: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

) 7

(~D

a Feeder: 1 ERDS Parameter: SG BD RAD 1A Point Id: 796ite Desc: STEAM GENERATOR BLOWDOWN RI-2601
ERDS Desc: STM GEN 1/A BLOWDOWN RAD LEVEL Analog/Digital: AEngr. Units: CPM Units Conv: n/a
Min. Inst. Range: 10 Max. Inst. Range: 10E6
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: PAB 44'6"
Alarm/Trip Set Points: 5000, high from RMS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/aInstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: Computer high alarm at 10000

Detector flow taps off the main flow for S/G gl. It isEdit <C:herds)MY1 DPL nRec 41/50 <File >RecLock n



Records isolated by trip valves fired by SXAS or containmentisolation.

Edit <C:gerds~MY1 DPL ~Rec 41/SO ~File nRecLock <
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DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

Feeder: 1 ERDS Parameter: SG BD RAD 2B Point Id: 795
ate Desc: STEAM GENERATOR BLOWDOWN RI-2602

ERDS Desc: STM GEN 2/B BLOWDOWN RAD LEVEL Analog/Digital: A
Engr. Units: CPM - Units Conv: n/a
Min. Inst. Range: 10 Max. Inst. Range: 10E6
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: PAB 44'6"
Alarm/Trip Set Points: 5000, high from RMS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: Computer high alarm at 10000

Detector flow taps off the main flow for S/G. It is
Edit nC:herds(MY1 DPL nRec 42/50 <File nRecLock n



Records isolated by trip valves fired by SIAS or containment
isolation.

Edit GC:KerdskMY1 DPL nRec 42/50 nFile >RecLock a



Records

Date: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: SG BD RAD 3C Point id: 794
e Desc: STEAM GENERATOR BLOWDOWN RI-2603

ERDS Desc: STM GEN 3/C BLOWDOWN RAD LEVEL Analog/Digital: AEngr. Units: CPM Units Conv: n/a
Min. Inst. Range: 10 Max. Inst. Range: 10E6Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens,: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: PAB 44'6"
Alarm/Trip Set Points: 5000, high at RMS
NI Detector Power Supply Cut-Off Power Level: n/aNI Detector Power Supply Turn-On Power Level: n/aInstrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: nLevel Reference Leg: n/a
System Desc: Computer high alarm at 10000

Detector flow taps of the main flow for S/G. It isEdit <C:gerds~MY1 DPL <Rec 43/SO <File ~RecLock <



Records isolated by trip valves fired by SIAS or containment
isolation.

Edit nC:herds)MY1 DPL >Rec 43/50 nFile ORecLock n
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DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

a Feeder: 1 ERDS Parameter: CTMNT PRESS Point Id: 835te Desc: CTMT PRESS PT-2012
ERDS Desc: CONTAINMENT PRESSURE Analog/Digital: A
Engr. Units: PSIA Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 200
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: PAB

21'larm/TripSet Points: 5, high from RPS
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit >C:herds(MY1 DPL nRec 44/50 <File nRecLock <
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Date: 08/31/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

Feeder: 1 ERDS Parameter: CTMNT TEMP Point Id: 312
e Desc: CTMT RTD CR-1 POLAR CRN OVER RX EL 106

ERDS Desc: CONTAINMENT TEMPERATURE Analog/Digital: A
Engr. Units: DEGF Units Conv: n/a
Min. Inst. Range: 50 Max. Inst. Range: 150
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: Over polar crane above reactor at

106'larm/TripSet Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit <C:herds)MY1 DPL <Rec 45/50 ~File nRecLock >



Records
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Records
DATA POINT LIBRARY REFERENCE FILE

Edit

Date: 12/03/92 Reactor Unit: MY1

Feeder: 1 ERDS Parameter: H2 CONC Point Id: 846
e Desc: CTMT HYDROGEN AY-1001-X

ERDS Desc: CONTAINMENT HYDROGEN CONCENTR. Analog/Digital: A
Engr. Units: Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 10
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: PAB

21'larm/TripSet Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: Samples containment atmosphere near top of containment.

Sampler must be manually aligned and started.
<C:gerds~MY1 DPL <Rec 46/50 <File nRecLock <



Records

Edit <C:gerds4MY1 DPL <Rec 46/50 GFile ~RecLock <
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DATA POINT LIBRARY REFERENCE FILE

Date: 12/03/92 Reactor Unit: MY1

Feeder: 1 ERDS Parameter: BWST LEVEL Point Id: 855
e Desc: RWST LVL LT-303AK

ERDS Deecl BORATED WATER STORAGE TANK LEVEL ~alog/Digital: A
Engr. Units: GALS ~ Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 360000
Zero Point Ref: COMPLX Ref. Notes: 12" above RWST base
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: in Service Yard b RWST
Alarm/Trip Set Points: 11 , ow from computer
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: N A
System Desc: 783.36 al in = 347,812 allon ca acit with 9,400 al

unmonxtore e ow instrument a s.
Edit <C:ger s <Rec 47 50 <File <RecLock <





Records

Edit <C:herds)MY1 DPL ~Rec 47/50 <File ~RecLock <





Records

I l~f~N
HAngC —) uurMi> -«/~Vcr i

DATA POINT LIBRARY REFERENCE FILE

Date: 12/03/92 Reactor Unit: MY1

Feeder: 1 ERDS Parameter: WIND SPEED Point Id: 474
e Desc: WND SPEED LWR

ERDS Desc: WIND SPEED AT THE REACTOR SITE Analog/Digital: A
Engr. Units: MPH Units Conv: n/a
Min. inst. Range: 0 Max. Inst. Range: 50
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: On site at 32 ft from ground level
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: LOW
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: n/a
Edit ~C:4erds~MY1 DPL <Rec 48/50 ~File <RecLock >



Records

i

Edit ~C:~erds~MY1 DPL cRec 48/50 cFile cRecLock <



Records

Date: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

Q a Feeder: 1 ERDS Parameter: WIND DIR Point Id: 472
e Desc: WND DIR LWR

ERDS Desc: WIND DIRECTION AT REACTOR SITE Analog/Digital: A
Engr. Units: DEG R Units Conv: n/a
Min. Inst. Range: 0 Max. Inst. Range: 540

'eroPoint Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: On site at 32 feet from ground level
Alarm/Trip Set Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: AS IS OR NORTH ON LOSS OF POWER
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: Parameter indicates direction wind is blowing from.

During cold weather, the indicator can freeze in position.Edit <C:herds)MY1 DPL ~Rec 49/50 nFile ~RecLock ~



0



Records

Edit ~C:herds(MY1 DPL ~Rec 49/SO GFile <RecLock >



Records

Date: 12/03/92

DATA POINT LIBRARY REFERENCE FILE

Reactor Unit: MY1

Feeder: 1 ERDS Parameter: STAB CLASS Point Id: 476
e Desc: DELTA TEMP 194-32 FT

ERDS Desc: AIR STABILITY AT REACTOR SITE Analog/Digital: A
Engr. Units: DEGF Units Conv: n/a
Min. Inst. Range: -8 'Max. Inst. Range: 20
Zero Point Ref: n/a Ref. Notes: n/a
Proc or Sens: S Number of Sensors: 1
How Processed: n/a
Sensor Loc: MET TOWER 195'ND

33'larm/TripSet Points: n/a
NI Detector Power Supply Cut-Off Power Level: n/a
NI Detector Power Supply Turn-On Power Level: n/a
Instrument Failure Mode: 0 FOR FULL FAILURE, HI/LO FOR 1 SENSOR
Temperature Compensation for DP Transmitters: n
Level Reference Leg: n/a
System Desc: DELTA TEMP = TEMP AT 195' TEMP AT

33'dit

>C:herds)MY1 DPL <Rec 50/50 nFile <RecLock >



TA6 5-5

EROS-GENERIC PARAMETER NAHES (PWRs)

Parameter Name Parameter Descri tion

7

io

i
13

lg
P>

lb
l7
ig

2<
2<

Z2.

23

f

25
24
21

RCS-PRESSURE gg7
NI- POWER- RNG Y5'C

N I - INTER-RNG

NI-SOURCE-RNG8 iV
REAC-VES-LV1 $ »
REAC-VES-LV2

REAC-VES-LV3

REAC-VES-LV4

REAC-YES-LV5

REAC-VES-LV6

REAC-VES-LV7

REAC-VES-LVS

EFF-GAS-RADI fIS
EFF-GAS-RA02

EFF-GAS-RA03

EFF-GAS-RA04

EFF-GAS-RA05

EFF-GAS-RAD6

EFF-LIQ-RADI 7qI
EFF- LIQ-RA02

COND-AE-RADI ~q ~

COND-AE-RA02

COND-AO-RAD3

COND-AD-RAD4

H2-CONC1

WINO-SPEEDl Y><
MIND-SPEE02

WINO-SPEE03

CA'i6) Reactor Coolant System Pressure R<s

~~o~~~)Nuclear Instruments, Power Range ~~ % i' ~'" «~~
"~'4i'~)NuclearInst, Intermediate Range

(cr s)Nuclear Inst, Source Range

i'0) Reactor Vessel Water Level 1 PiTS cia "
Reactor Vessel Water Level 2

Reactor Vessel Water Level 3

Reactor Vessel Water Level 4

Reactor Vessel Watg r Level 5

Reactor Vessel Mate Level 6

Reactor Vessel Water Level 7

Reactor Vessel Water Level 8

(i"~»~) Radioactivity of Released Gas 1

Radioactivity of Released Gas 2

Radioactivity of Released Gas 3

Radioactivity of Released Gas 4

Radioactivity of Released Gas 5

Radioactivity of Released Gas 6

(cP~) Radioactivity of Released Liq 1 <i<a>D w~svF ha.-c ~n~

Radioactivity of Released Liq 2

(caw) Condenser Air Ejec Rad 1 i.'o~vC~~ w
Condenser Air Ejec Rad 2

Condenser Air Ejec Rad 3

Condenser Air Ejec Rad 4

(%) Hydrogen Concentration I cr~: NA<ooca
~~ii) Wind Speed 1 at the Reactor Site

Mind Speed 2 at the Reactor Site
Wind Speed 3 at the Reactor Site
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TABLE 5-5 (Continued)

Parameter Name Parameter Oescri tion

3o
3(

$ 2

Z3
75

$ T

38
39

'/5'fT

56
5i

$3

5g

Ss
yC

57

WIND-DIRl$72
W IND-0IR2

WIND-DIR3

STAB-CLASSl +74
STAB-CLASS2

EXTRAl

EXTRA2

EXTRA3

EXTRA4

EXTRA5

EXTRA6

EXTRA7

EXTRA8

EXTRA9

EXTRA10

EXTRAll

EXTRA12

EXTRA13

EXTRA14

EXTRA15

EXTRA16

EXTRA17

EXTRA18

EXTRA19

EXTRA20

EXTRA21

EXTRA22

EXTRA23

EXTRA24

(~»Fe)Wind Direction i at the Reactor mP» y,g
Wind Direction 2 at the Reactor

Wind Direction 3 at the Reactor

Ci>~ <~ Air Stability 1 at the Reactor

Air Stability 2 at the Reactor

Extra Parameter 1

Extra Parameter 2

Extra Parameter 3

Extra Parameter 4

Extra Parameter 5

Extra Parameter 6

Extra Parameter 7

Extra Parameter 8

Extra Parameter 9

Extra Parameter 10

Extra Parameter ll
Extra Parameter 12

Extra Parameter 13

Extra Parameter 14

Extra Parameter 15

Extra Parameter 16

Extra Parameter 17

Extra Parameter 18

Extra Parameter 19

Extra Parameter 20

Extra. Parameter 21

Extra Parameter 22

Extra Parameter 23

Extra Parameter 24

Rev. 1
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TABlA 5-5 (Continued)

Parameter Name Parameter Descri tion

Sv
6o
Ci

4'z

N3

CC

47
6f

~

73

75

EXTRA25

EXTRA26

EXTRA27

EXTRA28

EXTRA29

EXTRA30

EXTRA31

EXTRA32

EXTRA33

EXTRA34

EXTRA35

GLOBAI 1

GLOBAL2

GLOBAL3

GLOBAL4

GLOBAL5

GLOBAL6

GLOBALT

GLOBALS

GLOBAL9

GLOBAL10

GLOBALll

GLOBAL12

GLOBAL13

GLOBAL14

GLOBAL15

GLOBAL16

GLOBAL17

GLOBAL18

Extra Parameter 25

Extra Parameter 26

Extra Parameter 27

Extra Parameter 28

Extra Parameter 29

Extra Parameter 30

Extra Parameter 31

Extra Parameter 32

Extra Parameter 33

Extra Parameter 34

Extra Parameter 35

Global Ad Hoc Parameter 1

Global Ad Hoc Parameter 2

Global Ad Hoc Parameter 3

Global Ad Hoc Parameter 4

Global Ad Hoc Parameter 5

Global Ad Hoc Parameter 6

Global Ad Hoc Parameter 7

Global Ad Hoc Parameter 8

Global Ad Hoc Parameter 9

Global Ad Hoc Parameter 10

Global Ad Hoc Parameter ll
Global Ad Hoc Parameter 12

Global Ad Hoc Parameter 13

Global Ad Hoc Parameter 14

Global Ad Hoc Parameter 15

Global Ad Hoc Parameter 16

Global Ad Hoc Parameter 17

Global Ad Hoc Parameter 18

Rev. 1
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~TABL 5-5 (Continued)

Parameter Name Paramet r Descri tion

Ss'v

vy

91

O'2

9A/

gs

9<

97

(0 2.

I03

/o5
lO4

lo7
t o$"

Io9
II 0

II 5

IIV
I I 5

liG

GLOBAL19

GLOBAL20

GLOBAL21

GLOBAL22

GLOBAL23

GLOBAL24

GLOBAL25

GLOBAL26

GLOBAL27

GLOBAL28

GLOBAL29

GLOBAL30

THP-CORE-EX1 I pug
TMP-CORE-EX2

SUB MARGIN1
gz'))'UB-MARG

IN2

CORE-FLOW1 2s'zo
CORE-FLOW2

CORE-FLOW3

CORE-FLOW4

SG-LEVEL1A 5 r 8

SG-LEVEL28 8'~V

SG-LEVEL3C @go

SG-LEVEL4D

SG-PRESS-1A 22 d)

SG-PRESS-28 >~~
SG-PRESS-3C > ~~
SG-PRESS-4D

MN-FD-FL-1A gl)

Global Ad Hoc Parameter 19

Global Ad Hoc Parameter 20

Global Ad Hoc Parameter 21

Global Ad Hoc Parameter 22

Global Ad Hoc Parameter 23

Global Ad Hoc Parameter 24

Global Ad Hoc Parameter 25

Global Ad Hoc Parameter 26

Global Ad Hoc Parameter 27

Global Ad Hoc Parameter 28

Global Ad Hoc parameter 29

Global Ad Ho(. Parameter 30

o~(') Core Exit Temperature 1

Core Exit Temperature 2

(ore t)Saturation Temp - Highest Cet 1

Saturation Temp - Highest Cet 2

(roe~)Reactor Coolant Flow 1 ~~ <««o~ W4 ~~a- i-p
Reactor Coolant Flow 2

Reactor Coolant Flow 3

Reactor Coolant Flow 4

(Q ) Steam Generator 1/A Water Level

(9) Steam Generator 2/8 Water Level S('

Wo) Steam Generator 3/C Water Level S(- 3 z.c=v'Wc

Steam Generator 4/0 Water Level

(P<ru)Steam Generator 1/A Pressure

(Ai(,)Steam Generator 2/8 Pressure

(f:/m) Steam Generator 3/C Pressure 56 ~
Steam Generator 4/0 Pressure

v

(~55~') Stm Gen 1/A Main Feedwater Flow sai w~ F„ ee~
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~TA E 5-5 (Continued)

Parameter Name Parameter Descr'ion

/F7

/i9

-
l3 l
l$Z

/77
I 3'/
l7$
>3C

l 's7

I 3f
I 3'g

/q'0

z dl/

l v2.

Isla

I Y4(

MN-FD-FL-2B )4,/ Z.
MN-FD-FL-3C I< I 3
MN-FD-FL-40

AX-FD-FL-1A gSZ
AX-FD-FL-2B E9'

AX-FD-FL-3C <'d'

AX-FD-FL-4D

HL-TEMP-1A g 3
HL-TEMP-2B $g I

HL-TEMP-3C $5'7

HL-TEMP-40

CL-TEHP-1A vso
CL-TEMP-2B l3'l
CL-TEMP-3C VZE

CL-TEMP-4D

PRZR-I EVEL R,D

RCS-CHG-HU 9(g
HPSI-FLOWl » ix
HPS I-FLOW2

HPS I-FLOW3

HPS I - FLOW4

HPS I - FLOW5

HPS I-FLOW6

LPS I - FLOW 1 k~ t l

LPS I - FLOW2

LPSI-FLOW3

LPS I - FLOW4

CTHNT-SP-NRl

CTMNT-SP-NR2

(>~/s,) Stm Gen 2/B Hain Feedwater Flow

/ ) Stm Gen 3/C Hain Feedwater Flow 5C > i'
+fj,1

Stm Gen 4/0 Hain Feedwater Flow
v

@Pm ~ Stm Gen 1/A AuX FeedWater F1OW ~l3[ / ~eR l='6 l v

( «") Stm Gen 2/B Aux Feedwater Flow
~'™)Stm Gen 3/C Aux Feedwater Flow

Stm Gen 4/C Aux Feedwater flow
(0<-+/Stm Gen 1/A Inlet Temperature
('oEcf) Stm Gen 2/B Inlet Temperature L./ z

nil.
(odaF)Stm Gen 3/C Inlet Temperature c.PZ

Stm Gen 4/D Inlet Temperature ~/ vdR
8~~"JStm Gen 1/A Outlet Temperature <I'>

(va /-")Stm Gen 2/B Outlet Temperature <p2-

(b~~6Stm Gen 3/C Outlet Temperatures.z 3

Stm Gen 4/0 Outlet Temperature

(gj) Primary System Pressurizer Level P<«+L ~" y ™O

(/l~) Primary Sys Charging/Makeup Flow

(gp ) High Pres 'Safety Inj Flow 1 ro'Tyl~ w~s/ ~z-o~

High Pres Safety Inj flow 2

High Pres Sa fety Inj F 1 ow 3

High Pres Safety Inj Flow 4

High Pres Safety Inj Flow 5

High Pres Safety Inj Flow 6

(<eN} Low Pres Safety Inj Flow 1

Low Pr es Safety Inj Flow 2

Low Pres Safety Inj Flow 3

Low Pres Sa fety Inj Fl ow 4

Containment Sump Narrow Range Lv

Containment Sump Narrow Range Lv
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~TABL 5-5 (Continued)

Parameter Name Parameter Descri tion

/g7
( da/g

Iqq
I 5O

ISI
I5>

t~(

"
|5g
I5'g

ICo

ICI

/C5
//CC

I 67

IC4

/4Q

CTMNT-SP-WRl

CTHNT-SP-WR2

CTMNT-SP-WR3

CTMNT-SP-WR4

CTMNT-SP-WRS

CTHNT-RADl 945
CTHNT-RAD2

RCS-LTD-RADl go)
RCS-LTO-RA02

HAIN-.SL-1A

MAIN-SL-28 5'2. K
HAIN-SL-3C 5Z 5

HAIN-SL-40

SG-BD-RAD- lA 7q(
SG-80-RAO-28 7$$
SG-80-RAO-3C 7VV
SG-80-RAO-40

CTHNT-PRESS gS 5

CTHNT-TEMP

BWST-LEVELl 8'<5

BWST-LEVEL2

INT-S I - FLOW1

INT-SI-FLOW2

INT-SI-FLOW3

(F") Containment Sump Wide Range Lv 1

Containment Sump Wide Range Lv 2

Containment Sump Wide Range Lv 3

Containment Sump Wide Range Lv 4

Containment Sump Wide Range Lv 5

(R/aa) Containment Radiation Level 1 =-. ~ ui cue goo
Containment Radiation Level 2

(Cp<) RCS Letdown Line Radiation Level A&~c. azrf»w~ ec

RCS Letdown Line Radiation Level

(~a/aa) Stm Gen 1/A Steam Line Rad Level

(~</~/e) Stm Gen 2/8 Steam Line Rad Level ~J ~ 4/J

(m /a<)Stm Gen 3/C Steam Line Rad Level m~ 5™
Stm Gen 4/D Steam Line Rad Level

(arm) Stm Gen 1/A Blowdown Rad Level <imam em>++~
d~"a'"'c.pnn)

Stm Gen 2/8 Blowdown Rad Level 5~~ «««~ 4t

(cI~) Stm Gen 3/C Blowdown Rad Level 5TT=<~

Stm Gen 4/0 Blowdown Rad Level

(AIe) Containment Pressure

<paaF)Containment Temperature

(c~Q Bor ated Water Storage Tank Level

Borated Water Storage Tank Level

Intermediate Safety Inj Flow 1

Intermediate Safety Inj Flow 2

Intermediate Safety Inj Flow 3
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